EECS 141: Spring 2006                                                           Bill Hung and Dennis Wang


Cadence Layout for SRAM Phase I
Bill Hung, Dennis Wang
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Opening a New Layout and New Library

File->New->Library
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Put “sram” in Library field in Library Manager and press Enter.
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Make the folder and proceed.

[image: image9.jpg]‘Technology File for New Library:

Help|

If you will be creating mask fayout or
other physical data in this fibrary, you
will need a technology file. If you plan
1o use only schematic or HDL data, a
technology file is not required.

Youcan: - Compile a new techfile
 Attach to an existing techfile
. Don't need a techfile




 OK
[image: image10.jpg]‘Attach Design Library to Technology

oK | cancel | pefauts| Ay | welp|

sren

How Desig Lbrary

Technology Library NCSU_TechLib_tsmco3d




OK
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 OK

SRAM Cell Transistors Layout

Ultimately, want to draw the following layout.
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Drawing NMOS

For now. Open NCSU_TechLib_tsmc03d->nmos->layout, and try to draw an NMOS 
myself. 
Table 1 PMOS Dimensions in Library NCSU_TechLib_tsmc03d Layout
	Name
	Height x Width

	Contact (cc)
	24 x 24

	Poly (poly)
	1.6 x 1.0

	Drain Metal (metal1)
	1.0 x 0.48

	Well (nactive)
	1.0 x 2.2

	Circumference (nselect)
	1.6 x 2.68


Table 2 Minimum PMOS and NMOS Sizes from Library NCSU_TechLib_tsmc03d
	Name
	Width / Length

	NMOS
	0.36um / 0.24um

	PMOS
	0.36um / 0.24um
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The layout by opening the NCSU_TechLib_tsmc03d library.

“r” nselect, nactive. Everything is dg, not nt in the LSW window.
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“r” metal1, cc. Notice the contacts have to be exactly 0.24um x 0.24um or DRC error.
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“r” poly
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“q”, then change the left, right, bottom, top to change the size.
Exploring Cadence Transistor Sizes
NMOS
Table 3 Actual NMOS Size for Phrase I
	Name
	Width x Height

	nselect (same as library)
	1.92 x 1.08

	nactive (Well)
	1.44 x 0.48

	metal1 (Drain metal)
	0.48 x 0.48

	poly
	0.24 x 0.96

	cc (contacts)
	0.24 x 0.24
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nactive below, library nmos above.
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Metal1
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Poly
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Nmos from library (left), and my nmos (right). They are exactly the same. DRC error free, extract error free.
PMOS
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The library cell by opening the NCSU_TechLib_tsmc03d library
Table 4 Actual PMOS Size for Phrase I

	Name
	Width x Height

	Nwell
	2.880 x 1.920

	pselect (orange box)
	1.920 x 1.080

	Pactive
	1.44 x 0.48

	metal1
	0.48 x 0.48

	cc (contacts)
	0.24 x 0.24

	Poly
	0.24 x 0.96
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nwell and pselect (orange box)
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pactive, metal1
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cc (contacts), poly
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DRC->   Total errors found: 0
Extract ->  Total errors found: 0

 Testing NMOS and PMOS Extraction

NMOS

Verify->Extract
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   Total errors found: 0
Open to the 3mos->extract
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Tools->Analog Environment->Setup Environment

Check “hspice” and “flat”, OK

Simulation->Netlist->Create Final

Save As -> ~/141/phrase1/min_nmos.sp
The extracted width and length agree with the layout (360nm x 240nm). The extracted hspice netlist is attached at the end.

PMOS

Open to the 3mos->extract
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Tools->Analog Environment->Setup Environment

Check “hspice” and “flat”, OK

Simulation->Netlist->Create Final

Save As -> ~/141/phrase1/min_pmos.sp
The extracted width and length agree with the layout (360nm x 240nm). The extracted hspice netlist is attached at the end.
Half SRAM Cell Transistors Layout
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This is the goal of the layout [Nikolic, lec 17 page 7]
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Layout Example Posted by TA [EE 141, Spring 2006]

Stick Diagram of the SRAM Cell Layout
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Figure 1SRAM Cell Layout Stick Diagram
Edit->Other->Rotate to rotate the transistors. cp and align them to meet the schematic given for 65nm SRAM
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Min distance (3.5 lambda) between nmos and pmos with DRC error.
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Access transistor (top), pull down nmos (left bottom), and pull up pmos (right)
[image: image35.png]



M1_POLY to metal1 min distance (3 lambda)
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M1_POLY contact and poly added to pmos
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Active contact to active spacing (5 lambda)
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Poly to poly contact (4 lambda), active contact to active spacing (3 lambda), so this makes the 2 pmos has 6 lambda apart instead of 5 lambda apart.
Wiring within the SRAM Cell with Contacts
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 are connected with metal 1 between M1 NMOS drain and M2 PMOS drain. DRC error free, extract was error free. The Hspice attached in appendix. The problem here is the metal 1 between M1 and M2 using metal 1 will connect the gate of pmos M4 also, which is not correct.
Contacts
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Contacts M1_POLY(left), M1_P(middle), M1_N (right)
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(from left) Contact M5_M4, M4_M3, M3_M2, M2_M1, NTAP
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(from left) NTAP = nwell/nselect/cc/m1 or nwell/m1_n, ntap, M1_P, PTAP
Now I try to make contacts on the gate of M5
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M2_M1 contact (left), M3_M2 contact (right) placed at the same place, onto of gate of M5 for Word Line (WL) connections.
Wiring word line
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* # FILE NAME: /HOME/AA/UGRAD/BILLHUNG/CADENCE/SIMULATION/SRAM_CELL/HSPICES/

* EXTRACTED/NETLIST/SRAM_CELL.C.RAW

* NETLIST OUTPUT FOR HSPICES.

* GENERATED ON MAR 17 23:45:35 2006

M0 5 7 14 2 TSMC25DP L=240E-9 W=360E-9 AD=273.599990319867E-15

+AS=273.599990319867E-15 PD=1.7999999499807E-6 PS=1.7999999499807E-6 M=1

M1 12 4 6 2 TSMC25DP L=240E-9 W=360E-9 AD=273.599990319867E-15

+AS=273.599990319867E-15 PD=1.7999999499807E-6 PS=1.7999999499807E-6 M=1

M2 13 7 9 11 TSMC25DN L=240E-9 W=480E-9 AD=165.599996280845E-15

+AS=288.000011209114E-15 PD=779.999993483216E-9 PS=1.67999996847357E-6 M=1

M3 10 4 15 11 TSMC25DN L=240E-9 W=480E-9 AD=288.000011209114E-15

+AS=165.599996280845E-15 PD=1.67999996847357E-6 PS=779.999993483216E-9 M=1

M4 8 3 13 11 TSMC25DN L=240E-9 W=360E-9 AD=273.599990319867E-15

+AS=165.599996280845E-15 PD=1.7999999499807E-6 PS=779.999993483216E-9 M=1

M5 15 3 1 11 TSMC25DN L=240E-9 W=360E-9 AD=165.599996280845E-15

+AS=273.599990319867E-15 PD=779.999993483216E-9 PS=1.7999999499807E-6 M=1

* INCLUDE FILES

* END OF NETLIST

.TEMP    25.0000

.OP

.save

.OPTION  INGOLD=2 ARTIST=2 PSF=2

+        PROBE=0

.END

Using M3, the horizontal wire in the graph, to connect the gate of the access transistors since according to the Layout Example Posted by TA, if we use M3 for vertical wiring, we need to use a lot of contact M1_M2 and M2_M3. 

Wiring 
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There is a problem when we use M1_M2 as a connection to vertical
[image: image51.wmf]-
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Therefore, I move M1_M2 contact on the left (WL connection) down, and move M1_M2 contact on the right (
[image: image52.wmf]-
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connection) away. Now it is DRC free again. Using M2 vertically to wire Vdd between the 2 pmos. The result is shown below. Hspice Netlist attached at the end.
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Instantiate N-tap

First attempt: laying down the N-tap in the middle and as close as to center, but unfortunately, it didn’t work
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Second attempt: putting the N-tap in the bottom-right corner, and it works
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Minimizing Wires
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Wire minimum width 0.36um, 3 lambda
Connecting the Grounds

[image: image57.png]=laix|

Help

[

S[=b

6

File

3
Help

av: -0.48

ax: 018

v:i-1a4 (F) Select: 0

X: 0,66

)

(s00S Rule 7.2) netall spacing: 0.36 un

" *Lagout

" “thres mos.

¢

Tocation:

Tools Design Window Create Edit Verify Connectivity Options Route NCSU

endOption()

R

M. LeHiMouseRapUp ()

Point at marker to explain

57 |nouse L: nouseadde()





The M1_M2 contact needs 4 lambda from metal 2 and 3 lambda from metal 1. So I moved the metal 2 of the bitline-bar to the right for half a lambda. Then DRC free.
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The metal 1 between M1_M2 contact and metal2 sticking up from M1_M2 contact were drawn. The spacing between metal 2 is at least 4 lambda. So move the gound metal 2 to the right. Then DRC free.
[image: image59.png]



Move the metal 2 contact to the right to remove metal 2 DRC error. They need 4 lambda apart.
[image: image60.png]



After long discussion with Dennis, we decided in order to put the ntap in the cell, we have no choice but to increase the horizontal distance by half a lambda. The result is DRC free.
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Connecting the grounds through metal1-metal2-metal3-metal2-metal1. DRC error free, extract error free.
Connecting the VDD

[image: image62.png]



The ground is connected to the ntap through metal 1. The wire between them has to be 4 lambda instead of the minimum 3 lambda or DRC error.
Final Layout
[image: image63.png]



After putting the ptaps at the corners. DRC and extra error free. The hspice gives the right circuit (attached). YES!
Final Postscript Plot
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Testing with Repetitive Pattern
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The layout we have so far can not be flipped correctly since the gates of the access transistor should be center at the rotation axis.

[image: image66.png]



After move the center of the poly contact, it is now DRC free 
APPENDIX
Cadence Shortcut Keys
Table 5 Cadence Shortcut Keys

	Shortcut Key
	Meaning

	C
	Copy

	M -> Flip Upside Down
	Flip

	O
	Contact


Failure Notes, mistakes that I learned from trial and error

1. contacts have to be exactly 0.24um x 0.24um or DRC error.
2. [image: image67.png]



 Tried the exact dimension in Table 1, they didn’t work for me. Those are the sizing parameters from the library layout. I made an nmos with the same exact dimension of the library transistor, but it ends up with lots of DRC errors. So finally opening the inverter from HW instead for sizing.
HSPICE Minimum NMOS Extracted Netlist
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* # FILE NAME: /HOME/AA/UGRAD/BILLHUNG/CADENCE/SIMULATION/3MOS/HSPICES/         

* EXTRACTED/NETLIST/3MOS.C.RAW

* NETLIST OUTPUT FOR HSPICES.

* GENERATED ON MAR 16 23:33:20 2006

M0 5 3 6 2 TSMC25DN L=240E-9 W=360E-9 AD=273.599990319867E-15 

+AS=273.599990319867E-15 PD=1.7999999499807E-6 PS=1.7999999499807E-6 M=1 

M1 7 4 1 2 TSMC25DN L=240E-9 W=360E-9 AD=273.599990319867E-15 

+AS=273.599990319867E-15 PD=1.7999999499807E-6 PS=1.7999999499807E-6 M=1 

* INCLUDE FILES

* END OF NETLIST

.TEMP    25.0000    

.OP

.save

.OPTION  INGOLD=2 ARTIST=2 PSF=2

+        PROBE=0

.END 
HSPICE Minimum PMOS Extracted Netlist
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* # FILE NAME: /HOME/AA/UGRAD/BILLHUNG/CADENCE/SIMULATION/3MOS/HSPICES/         

* EXTRACTED/NETLIST/3MOS.C.RAW

* NETLIST OUTPUT FOR HSPICES.

* GENERATED ON MAR 17 00:39:30 2006

M0 11 2 8 5 TSMC25DP L=240E-9 W=360E-9 AD=273.599990319867E-15 

+AS=273.599990319867E-15 PD=1.7999999499807E-6 PS=1.7999999499807E-6 M=1 

M1 6 13 12 5 TSMC25DP L=240E-9 W=360E-9 AD=273.599990319867E-15 

+AS=273.599990319867E-15 PD=1.7999999499807E-6 PS=1.7999999499807E-6 M=1 

M2 9 4 10 3 TSMC25DN L=240E-9 W=360E-9 AD=273.599990319867E-15 

+AS=273.599990319867E-15 PD=1.7999999499807E-6 PS=1.7999999499807E-6 M=1 

M3 14 7 1 3 TSMC25DN L=240E-9 W=360E-9 AD=273.599990319867E-15 

+AS=273.599990319867E-15 PD=1.7999999499807E-6 PS=1.7999999499807E-6 M=1 

* INCLUDE FILES

* END OF NETLIST

.TEMP    25.0000    

.OP

.save

.OPTION  INGOLD=2 ARTIST=2 PSF=2

+        PROBE=0

.END

HSPICE Q-bar between M1 NMOS drain and M2 PMOS drain
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* # FILE NAME: /HOME/AA/UGRAD/BILLHUNG/CADENCE/SIMULATION/SRAM_CELL/HSPICES/    

* EXTRACTED/NETLIST/SRAM_CELL.C.RAW

* NETLIST OUTPUT FOR HSPICES.

* GENERATED ON MAR 17 20:38:00 2006

M0 10 12 9 5 TSMC25DP L=240E-9 W=360E-9 AD=273.599990319867E-15 

+AS=273.599990319867E-15 PD=1.7999999499807E-6 PS=1.7999999499807E-6 M=1 

M1 4 10 12 5 TSMC25DP L=240E-9 W=360E-9 AD=273.599990319867E-15 

+AS=273.599990319867E-15 PD=1.7999999499807E-6 PS=1.7999999499807E-6 M=1 

M2 10 12 7 2 TSMC25DN L=240E-9 W=480E-9 AD=165.599996280845E-15 

+AS=288.000011209114E-15 PD=779.999993483216E-9 PS=1.67999996847357E-6 M=1 

M3 8 10 12 2 TSMC25DN L=240E-9 W=480E-9 AD=288.000011209114E-15 

+AS=165.599996280845E-15 PD=1.67999996847357E-6 PS=779.999993483216E-9 M=1 

M4 6 3 10 2 TSMC25DN L=240E-9 W=360E-9 AD=273.599990319867E-15 

+AS=165.599996280845E-15 PD=1.7999999499807E-6 PS=779.999993483216E-9 M=1 

M5 12 11 1 2 TSMC25DN L=240E-9 W=360E-9 AD=165.599996280845E-15 

+AS=273.599990319867E-15 PD=779.999993483216E-9 PS=1.7999999499807E-6 M=1 

* INCLUDE FILES

* END OF NETLIST

.TEMP    25.0000    

.OP

.save

.OPTION  INGOLD=2 ARTIST=2 PSF=2

+        PROBE=0

.END
The node 12 is Q-bar. I noticed the pmos M1 in the netlist and the two big nmos (M2 and M3 in the netlist) are connected.  This is good.
The netlist suggests that with a metal 1 connecting M1 and M2 in the stick diagram (Figure 1) will connect the gate of M4. This is what we want
HSPICE Wiring 
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In the netlist extraction (we can’t tell if BL will be properly connected at this stage, but we are sure that the two half cells are connected together; Qbar corresponding to node 9 whereas Q corresponding to node 10. Vdd is node 4)

* # FILE NAME: /HOME/AA/UGRAD/BILLHUNG/CADENCE/SIMULATION/SRAM_CELL/HSPICES/

* EXTRACTED/NETLIST/SRAM_CELL.C.RAW

* NETLIST OUTPUT FOR HSPICES.

* GENERATED ON MAR 18 12:19:53 2006

M0 9 10 4 3 TSMC25DP L=240E-9 W=360E-9 AD=273.599990319867E-15

+AS=273.599990319867E-15 PD=1.7999999499807E-6 PS=1.7999999499807E-6 M=1

M1 4 9 10 3 TSMC25DP L=240E-9 W=360E-9 AD=273.599990319867E-15

+AS=273.599990319867E-15 PD=1.7999999499807E-6 PS=1.7999999499807E-6 M=1

M2 9 10 6 2 TSMC25DN L=240E-9 W=480E-9 AD=165.599996280845E-15

+AS=288.000011209114E-15 PD=779.999993483216E-9 PS=1.67999996847357E-6 M=1

M3 7 9 10 2 TSMC25DN L=240E-9 W=480E-9 AD=288.000011209114E-15

+AS=165.599996280845E-15 PD=1.67999996847357E-6 PS=779.999993483216E-9 M=1

M4 5 8 9 2 TSMC25DN L=240E-9 W=360E-9 AD=273.599990319867E-15

+AS=165.599996280845E-15 PD=1.7999999499807E-6 PS=779.999993483216E-9 M=1

M5 10 8 1 2 TSMC25DN L=240E-9 W=360E-9 AD=165.599996280845E-15

+AS=273.599990319867E-15 PD=779.999993483216E-9 PS=1.7999999499807E-6 M=1

* INCLUDE FILES

* END OF NETLIST

.TEMP    25.0000

.OP

.save

.OPTION  INGOLD=2 ARTIST=2 PSF=2

+        PROBE=0

.END

HSPICE After Ground Metal 2 Rail
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* # FILE NAME: /HOME/AA/UGRAD/BILLHUNG/CADENCE/SIMULATION/SRAM_CELL/HSPICES/    

* EXTRACTED/NETLIST/SRAM_CELL.C.RAW

* NETLIST OUTPUT FOR HSPICES.

* GENERATED ON MAR 18 17:54:03 2006

M0 9 10 4 3 TSMC25DP L=240E-9 W=360E-9 AD=273.599990319867E-15 

+AS=273.599990319867E-15 PD=1.7999999499807E-6 PS=1.7999999499807E-6 M=1 

M1 4 9 10 3 TSMC25DP L=240E-9 W=360E-9 AD=273.599990319867E-15 

+AS=273.599990319867E-15 PD=1.7999999499807E-6 PS=1.7999999499807E-6 M=1 

M2 9 10 6 2 TSMC25DN L=240E-9 W=480E-9 AD=165.599996280845E-15 

+AS=288.000011209114E-15 PD=779.999993483216E-9 PS=1.67999996847357E-6 M=1 

M3 7 9 10 2 TSMC25DN L=240E-9 W=480E-9 AD=288.000011209114E-15 

+AS=165.599996280845E-15 PD=1.67999996847357E-6 PS=779.999993483216E-9 M=1 

M4 5 8 9 2 TSMC25DN L=240E-9 W=360E-9 AD=273.599990319867E-15 

+AS=165.599996280845E-15 PD=1.7999999499807E-6 PS=779.999993483216E-9 M=1 

M5 10 8 1 2 TSMC25DN L=240E-9 W=360E-9 AD=165.599996280845E-15 

+AS=273.599990319867E-15 PD=779.999993483216E-9 PS=1.7999999499807E-6 M=1 

* INCLUDE FILES

* END OF NETLIST

.TEMP    25.0000    

.OP

.save

.OPTION  INGOLD=2 ARTIST=2 PSF=2

+        PROBE=0

.END
HSPICE After Ground Metal 3 Connection
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* # FILE NAME: /HOME/AA/UGRAD/BILLHUNG/CADENCE/SIMULATION/SRAM_CELL/HSPICES/    

* EXTRACTED/NETLIST/SRAM_CELL.C.RAW

* NETLIST OUTPUT FOR HSPICES.

* GENERATED ON MAR 18 20:57:07 2006

M0 3 8 4 1 TSMC25DP L=240E-9 W=360E-9 AD=273.599990319867E-15 

+AS=273.599990319867E-15 PD=1.7999999499807E-6 PS=1.7999999499807E-6 M=1 

M1 4 3 8 1 TSMC25DP L=240E-9 W=360E-9 AD=273.599990319867E-15 

+AS=273.599990319867E-15 PD=1.7999999499807E-6 PS=1.7999999499807E-6 M=1 

M2 3 8 7 5 TSMC25DN L=240E-9 W=480E-9 AD=165.599996280845E-15 

+AS=288.000011209114E-15 PD=779.999993483216E-9 PS=1.67999996847357E-6 M=1 

M3 7 3 8 5 TSMC25DN L=240E-9 W=480E-9 AD=288.000011209114E-15 

+AS=165.599996280845E-15 PD=1.67999996847357E-6 PS=779.999993483216E-9 M=1 

M4 6 2 3 5 TSMC25DN L=240E-9 W=360E-9 AD=273.599990319867E-15 

+AS=165.599996280845E-15 PD=1.7999999499807E-6 PS=779.999993483216E-9 M=1 

M5 8 2 9 5 TSMC25DN L=240E-9 W=360E-9 AD=165.599996280845E-15 

+AS=273.599990319867E-15 PD=779.999993483216E-9 PS=1.7999999499807E-6 M=1 

* INCLUDE FILES

* END OF NETLIST

.TEMP    25.0000    

.OP

.save

.OPTION  INGOLD=2 ARTIST=2 PSF=2

+        PROBE=0

.END

Final HSPICE SRAM Cell Extracted
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* # FILE NAME: /HOME/AA/UGRAD/BILLHUNG/CADENCE/SIMULATION/SRAM_CELL/HSPICES/    

* EXTRACTED/NETLIST/SRAM_CELL.C.RAW

* NETLIST OUTPUT FOR HSPICES.

* GENERATED ON MAR 18 22:14:53 2006

M0 2 5 1 1 TSMC25DP L=240E-9 W=360E-9 AD=273.599990319867E-15 

+AS=273.599990319867E-15 PD=1.7999999499807E-6 PS=1.7999999499807E-6 M=1 

M1 1 2 5 1 TSMC25DP L=240E-9 W=360E-9 AD=273.599990319867E-15 

+AS=273.599990319867E-15 PD=1.7999999499807E-6 PS=1.7999999499807E-6 M=1 

M2 2 5 7 7 TSMC25DN L=240E-9 W=480E-9 AD=165.599996280845E-15 

+AS=288.000011209114E-15 PD=779.999993483216E-9 PS=1.67999996847357E-6 M=1 

M3 7 2 5 7 TSMC25DN L=240E-9 W=480E-9 AD=288.000011209114E-15 

+AS=165.599996280845E-15 PD=1.67999996847357E-6 PS=779.999993483216E-9 M=1 

M4 4 3 2 7 TSMC25DN L=240E-9 W=360E-9 AD=273.599990319867E-15 

+AS=165.599996280845E-15 PD=1.7999999499807E-6 PS=779.999993483216E-9 M=1 

M5 5 3 6 7 TSMC25DN L=240E-9 W=360E-9 AD=165.599996280845E-15 

+AS=273.599990319867E-15 PD=779.999993483216E-9 PS=1.7999999499807E-6 M=1 

* INCLUDE FILES 

* END OF NETLIST

.TEMP    25.0000    

.OP

.save

.OPTION  INGOLD=2 ARTIST=2 PSF=2

+        PROBE=0

.END
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